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Quark XPress, Adobe PageMaker, or Corel
Ventura that are available for efficient document
layout and design, many of us still are relegated
to using standard word processing software such
as Microsoft Word. As a result, we have to learn
to be as industrious as possible in using some of
the program’s less-known useful features. For 7
instance, after painstakingly performing endless

global searches and replacements to correct in-

chapter number” checkbox is selected, and
define which style marks the beginning of the
chapter (here, “Heading 17). Select a separator
in the “Use separator” field to distinguish
between the chapter and figure numbers.

. In the Caption: field, type the figure’s title.

text references to figures and tables, I finally 2
learned how to actually link figures and tables Caption:
with their captions and with their in-text | Figure 1
references. Options

Linking figures and tables to captions and to Lz |Figure =l MewLabel... |
in-text references lets editors quickly and Paosition: |Belowselected item =l Delete Labsl |
accurately update both the captions and their hmbering... |
references within the text. This article demon-
strates how to accomplish these tasks in Micro- AutoCaption... | [ ok | coneel |
soft Word.

Figure 1. The Caption dialog box.
Figure captions

1. Position the cursor below the image, then .
press Enter to insert a blank line. 21X
2. Select the image by clicking on it with the Farmat: [23 . =l
left mouse button.
3. Open the Insert menu and select Caption...
to display the options for captions (Figure 1). Chapter starts wich style [Headng 1 -]
4. In the Label: field, select Figure. Lo I T j
5. In the Position: field, select “Below selected _
. ” Examples: Figure II-1, Table 1-4
item”.
6. Click the “Numbering...” button to display
the options available for numbering the

Cancel |
image (Figure 2). If you are using chapter-

based numbering, ensure that the “Include Figure 2. The Caption Numbering dialog box.

[ Include chapter number

(continued on page 5)
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Editorial: Don’t
let the errors
stand

unchallenged
By Geoff Hart

Everybody agrees
that the current state of science education is
pitiful, but nobody does anything about it.
At least, that’s been the conventional wisdom
until recently. Physicist John Hubisz
(Hubisz@unity.ncsu.edu) has been fighting a
losing battle to correct the problems for decades,
but now hopes to leverage the power of the
Internet and its activist communities to make a
difference. At the Science House Web site
(www.science-house.org), sponsored by North
Carolina State University in Raleigh, Hubisz is
an active participant in providing online learning
resources for science teachers. In particular, he’s
provided a resource that he hopes will grow
rapidly: online reviews of current science texts
(www.science-house.org:8530/middleschool/
reviews/), and lists of their errors, which are
sometimes quite egregious (e.g., a map showing
the equator running through Florida).

The American Association for the
Advancement of Science is also working to
provide our children with a better science
education. Their Project 2061 has the goal of
reforming “K-12 education nationwide so that
all high-school graduates are literate in science,
mathematics, and technology”. Have a look
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at their Web site (project2061@aaas.org,
www.aaas.org/project2061/) for details on the
project and links to miscellaneous useful
information.

As scientific communicators, we obviously
have a keen interest in explaining science to
diverse audiences, including the public. That
task is much easier if our audiences have some
basic understanding of science, and providing
that understanding is the role of science teachers.
How can you play a part? At a minimum, point
your children’s teachers to these two Web sites
and encourage them to consult the available
reference material, including Hubisz’s reviews. If
you're feeling more ambitious, contact Dr.
Hubisz or AAAS and offer to help out. If, like
me, youre a fan of science fiction, check out
Julie Czerneda’s Web site (www.czerneda.com/
nolimits.htm) for details on her No Limits
project, a classroom resource to help teachers
stimulate interest in science using science fiction
as a teaching resource. Point your local teachers
to this great resource.

It would also be interesting to get STC
involved in these efforts, both to increase the
Society’s visibility and to increase our SIG’s
visibility within the society. Any volunteers? Q

“The true scientist has to be intent on cooperation
in a communal enterprise, or it will not work at all.
And to the extent that we know well, and love
deeply, we are all true scientists. So we will keep
inventing that community of trust."—Kim Stanley
Robinson, Antarctica
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Letters to the Editor

More data on data

Methinks Brer Gosler (the Exchange, V9:2)
is flogging a putrefying Percheron. In
engineering, at least, data has been singular for at
least 30 years and probably more. I have been
knocked from my sturdy steed numerous times
while tilting at this particular windmill. The
only place I know at present where datum is still
used in engineering is in land surveying. There,
datum line has a specific meaning. —Dan Wise,
Associate Fellow, Birmingham Chapter

Other work opportunities

My significant other had a post-college job
as a production editor on a medical journal and
encouragement from her boss helped her decide
to go to medical school. So she happens to be
one of those doctors who writes well. As a
consequence, she has developed quite a series of
patient handouts to explain the limited number
of conditions she encounters in her specialty and
to guide patients through the self-care and
follow-up they require. This material merely

reinforces what she conveys to her patients
orally.

Her patients love the handouts, which are
now in use by other physicians in her specialty,
but most doctors I've encountered have very
little of this kind of material. Usually it’s a
brusque sentence while 'm in the room and an
illegible scrawl at the bottom of an all-purpose
patient instruction form with a couple of boxes
checked. If my condition is one for which there
is a printed brochure furnished by a drug maker,
the doctor may hand me that, too. That, it
seems to me, is a golden opportunity for some
entrepreneurial tech writer to exploit. I don’t
think there is a big opportunity with primary
care providers (PCPs). They deal with too many
different conditions and don’t get paid well these
days. But I think there is a real opportunity with
specialists. So call up your PCP and ask for
referrals! (They’re used to that, right?) Specialists
deal with a limited range of conditions and
many would probably welcome a chance to get
their handouts spruced up, edited, or written in
the first place.—Dick Margulis

Proposed merger with the ES&H SIG: the Science SIG perspective
by Geoff Hart, Science SIG manager

On page 4, Hillary Hart, manager of the Environmental, Safety, and Health Communication SIG
explains why she proposes a merger between our two SIGs. As you'll see, I'm in favor of the merger.
I've polled the Science SIG e-mail discussion group (see page 8), and the responses thus far have been
largely positive; the only serious concern that’s been raised is the risk of undermining what we've
accomplished as a SIG. If we can retain our SIG’s unique strengths and enhance them by adding
members from ES&H, I recommend that we proceed with the merger. If you disagree, please let me
know by e-mail so we can discuss it. If nobody raises an unresolvable objection, Hilary and I will
formally propose to STC that the SIGs be merged by the end of the year. Then, of course, comes the
challenge of choosing a new name for the SIG. Stay tuned.

Serious objections, of course, have to be discussed, and our e-mail discussion group is the best
place to do that because it permits immediate and interactive discussion. We had some minor
problems with the software that runs the list, so if you didn’t receive any of the messages discussing the
merger, log into the Web site and check your subscription information. Q

(continued on page 4)
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Proposed merger with the ES&H

SIG: the ES&H perspective
by Hillary Hart (hart@mail.utexas. edu)
Manager, ES&H SIG

For the last couple of years, I have been
talking informally with ES&H SIG members
about the possibility of merging with the
Science SIG. Why? Well, for one thing, our SIG
is pretty small—it’s actually the smallest Special
Interest Group within STC, fluctuating
somewhere around 300 members. This size
makes it difficult to rally volunteers or resources
to be as effective as we could be for our
membership. The second reason is that many
ES&H members are members of both SIGs and
are unclear, as are the managers, about what the
differences really are. Medical writing probably
belongs in Science Communication, but what
about writing that focuses on the relationship
between public health and prescription drugs. Is
that health and safety writing or is it medical?
What about writers at the national labs? A lot of
environmental work goes on there, but surely
they are “science” writers?

What are the benefits of combining the two
SIGs? Answer: more resources. And thereby,
more stability. Geoff Hart, recently appointed
manager of the Science SIG, says, “. . . given the
small sizes of our two SIGs, it might make sense
to merge and pool our resources.” Geoff cites
these advantages of a merger: “More bodies,
more dialog within the SIG, and more of a
presence at STC, which means more security.
STC’s budget has been hit reasonably hard by

the dotcom meltdown and the travails of the

high-tech industry, and they’re looking to trim
costs wherever possible. Small SIGs are an
obvious target.”

The Science SIG is a lot larger, about 800
members, so a combined SIG ought to have a
membership of slightly over 1000. We cannot
seem to determine, easily, how many of you
are members of both SIGs, but I suspect at least
20%. So we might not break 1000 in
membership, but that’s still a significant increase
for the Science SIG. And you’ll only have to
join one SIG next year!

A merger means a bigger budget and more
leaders within the SIG to serve you. Science has
a terrific content-laden newsletter (but no Web
site); ES&H has a terrific-looking and
functional Web site (but a very irregular news-
letter). As long as we make sure both Web site
and newsletter contain content relevant to
environmental, safety, health, and science
writers—to those working in a regulatory
environment and those working in a research or
science environment—the merger should
provide significant advantages.

At the last STC annual conference, in
Nashville, I informally polled about thirty
members of both SIGs and found good
enthusiasm for a proposed merger. Bur we want
to hear from you. Please let us know your
thoughts about the merger. We can make this
happen before the end of the membership year
(February ’03), but we need to know that the
great majority of you are in favor and there is
not some major drawback we haven’t thought
about. Let us know your thoughts, whether pro
or con. Q

“The tendency of pop Darwinism—which, in one form or another, has been shaping American culture for well
over a century—is to look at what we want, explain it in terms of what our genes want, and then suggest
that what our genes want is what we really want. Our genes’ hidden agenda—namely their own proliferation
in human bodies, from here to eternity—is supposed to be our agenda... This is like saying that our felicity
lies in achieving a state of entropy or heat death, which seems to be the agenda of the subatomic particles
that must, in the last and rather tedious analysis, set in motion all our desires.”

—Evan Eisenberg, The Adoption Paradox
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“Figures and tables...” (continued from page 1)

Note: Most Word dialog boxes let you select
and copy text from the document, then paste
it into a suitable field. For longer captions,
this shortcut can save lots of typing.

. Click the OK button. The formatted caption

appears below the figure, and remains linked
with the figure thereafter.

Table captions

1.

To link the caption to the table, begin by
placing the cursor in the topmost cell of the
table. Open the Table menu and select Insert
Rows.

. Position the cursor in the new row, then

select that entire row. You can do so in two
ways:

move the mouse cursor to the left of the row
until it turns into a right-facing arrow, then
click the left mouse button, or

position the text cursor in the first cell and
move through each subsequent cell in the
row using the arrow keys while holding

down the Shift key.

. Merge all cells in the new row into a single

cell by opening the Table menu and selecting
Merge Cells.

. Remove any unnecessary shading and borders

by clicking inside the row with the right
mouse button, selecting “Borders and
Shading” from the popup menu, and
deselecting any unnecessary border and
shading options.

. Open the Insert menu and select Caption...

to display the caption dialog box.

. In the Label: field, select Table (Figure 3).
. In the Position: field, select “Above selected

. »
item .

. Click the “Numbering...” button to display

the options available for numbering (Figure
2). If you are using chapter-based numbering,
ensure that the “Include chapter number”
checkbox is selected, and define the styles
used to define the start of the chapter and the
separator.
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9.

In the Caption: field, type the table’s title.
Note: Most Word dialog boxes let you select
and copy text from the document, then paste
it into a suitable field, which can save lots of
typing for longer captions.

10. Click the OK button. The formatted table

caption appears above the table. If too much
space appears between the caption and the
top of the table, you can decrease the spacing
by highlighting the caption, opening the
Format menu, selecting Paragraph..., and
changing the size of the spacing in the
Before: and After: fields.
Note: If the top border of the table
disappears, you can restore it by highlighting
the entire top row of text in the table (not
the caption), clicking on the selected row
with the righthand mouse button, and
selecting Borders and Shading.... Select the
Borders tab, then add the desired borders.

Creating an in-text cross-reference to a
figure or table

Once you've created the captions for figures  “Once you've
and tables, you can save considerable revision  createdthe
time by linking automatically to them. To link ~ ¢aptions for

. . figures and
to a specific caption:
o h he i tables, you
1. Position the cursor where you want the in- 5 save
text reference to appear. considerable
2. Open the Insert menu and select Cross-  revision time
reference. ... The screen in Figure 4 appears. by linking
. automatically
3. In the Reference type: field, select Figure or "
« . Ly . to them
Table. The “For which caption” field displays
all figures and tables that you have defined.
[y 21 x|
Capkion:
| Tahlel
Qptions
Label: ITabIe j Mew Label, .. |
Position: Inbnve selected item j Delete Label |
Murnbering. .. |

AuktoCaption. . | [0]'8 I Cancel I

Figure 3. Selecting the “table” type of caption.
(continued on page 6)
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“With a few
key-
strokes,
Word lets
you ensure
that your
caption and
column
headings
will appear
at the top
of the table
on all
subsequent
pages”

Cross-reference

Reference bvpe:

“Figures and tables...” (continued from page 5)

4. In the “Insert reference to:” field, select Entire
caption. This will ensure that the words
“figure” or “table,” the chapter number (if
any), and the image number appear in the
link. (You can edit the results, but don’t
delete or retype either the chapter or figure
number; these are links maintained by Word,
and retyping either one may break the link.)

5. Ensure that the “Insert as hyperlink” box is
checked.

6. In the “For which numbered item:” field,
select the appropriate figure or table title and
click the Insert button. The caption title now
appears in the document as a link.

Updating in-text references

1. Select the caption text.

2. Press the keyboard’s F9 key.

3. The in-text reference to the figure or table
caption will automatically update to reflect
the actual caption.

Using continuing headings for tables in
Microsoft Word

Occasionally, we find that our tables span
multiple pages. Fortunately, there’s no reason to
manually regenerate the column headings and
table caption on each page. With a few
keystrokes, Word lets you ensure that your

Insert reference to:

IEntire capkion j
[T Include above/below

Insert | Cancel |

Figure 4. Inserting a cross-reference.

caption and column headings will appear at the
top of the table on all subsequent pages.

When a table spans several pages of a
document, it’s very helpful to readers if you
repeat the column headings on those pages.
Once the table has been created and formatted,
select the column headings (row of cells) that
you want to repeat on each page, then open the
Table menu and select Headings (Figure 5). The
Headings menu choice will henceforth display a
checkmark whenever the cursor is positioned in
these cells, and the column headings will now
appear at the top of the table on all subsequent
pages. However, you will not be able to edit
these headings on those pages; changes to a
column heading must be made in the cells that
contain the headings at the beginning of the
table.

& Drawm Table

o |
T Insert Rows

Delete Cells, ..

IMerge Cells
e split Cells. ..

Select Row
Select Colurmn
Select Tahle

ﬁ Table AutoFormat. ..

3} Dpistribute Rows Evenly
FH Diskribute Columns Evenly
and Width. ..

Texh ba Table...

El Sark. ..
Formula. ..
Split Table

(5 show aridlines

Figure 5. Confirming that a table cell has been set
to act as a “heading”.

(continued on page 7)
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“Figures and tables...” (continued from page 6)

Adding the table caption to the
continuing header

Naturally, a table will also have a caption to
identify its title. If the table flows onto multiple
pages, it’s always a good idea to reidentify the
table on each page so readers won’t have to flip
back to the first page of the table to find the
title. Following the instructions earlier in this
article, create a caption for the table in the first
line of the table rather than as a separate
paragraph outside the table.

Once you've created the table caption,
highlight the entire row that contains it. To
remove borders from this cell (or apply borders,
if that’s your preferred style), open the Table
menu and select Borders and Shading... Click
the Borders tab, and beside the Preview portion
of the box, select or deselect border options
until you achieve the desired effect. Once you've
formatted the cell appropriately, open the Table
menu and select Headings. As was the case for
the column headings, the table caption will now
repeat on each consecutive page and will only be

editable on the first page of the table. Q

Gary Michael Smith is a Senior Documentation
Specialist with CACI at the Information
Technology Center in New Orleans. He teaches
three courses at the University of New Orleans
(book publishing, writing, and resume
development) and is author of 7 nonfiction books
and more than 100 articles for 34 technical and
trade publications. He can be reached at

www. ChatgrisPress.com.

“False facts are highly injurious to the progress of
science, for they often endure long; but false
views, if supported by some evidence, do little
harm, for every one takes a salutary pleasure in
proving their falseness.”—Charles Erasmus Darwin

“I don’t think you can be a true democracy unless
you understand the important scientific issues of
modern life, especially in the environmental and
energy fields.—Arjun Makhijani
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Style guidelines for submitting

journal manuscripts
by Geoff Hart

Just as no two editors agree on every detail
of editorial style and no two writers will take
the same approach to describing a concept, so
it is that journals tend to have their own
idiosyncratic stylistic quirks. Although a
superbly written manuscript about exciting,
well-designed research will always be pub-
lished—eventually—and a journal’s copyeditors
will help authors to follow house style,
following the journal guidelines in the first place
greatly reduces the barriers to publication. Some
journals even explicitly state that they’ll return
manuscripts unread if they don’t meet the
journal’s formatting and other submission
guidelines.

One powerful tool offered by the Internet is
the ability to find guidelines to authors on a
publisher’s Web site. For example, check out the
guidelines to authors published by Elsevier
(http://authors.elsevier.com/) and the National
Research Council of Canada (www.nrc.ca/cgi-
bin/cisti/journals/rp/rp2_jour_e) for guidelines
from these two major publishers.

Where you can’t find a specific journal’s style
guidelines, it’s generally wise to follow a good
subject-specific style guide. Some of these are
also available online, such as the “Uniform
requirements for manuscripts submitted
to biomedical journals” (www.cma.ca/cma/
common/displayPage.do?pageld=/staticContent/
HTML/NO/I2/publications/mwc/
uniform.htm).

Do you have a favorite online style guide?
Share it with us! While I'm on the subject of
sharing, let me formally introduce you to Alane
Alchorn (alchorn1@llnl.gov), who has vol-
unteered to begin getting our SIG’s Web site up
and running. If you come across other useful
online references, please contact Alane with the
information. Q



Join us on STC'’s Scientific Communication SIG mailing list!

STC runs an Internet-based e-mail discussion group for the Science SIG. It’s a quiet, friendly
place to turn for help if you've got questions concerning scientific communication. If youd like to
join, point your Web browser to http://lists.stc.org/cgi-bin/lyris.pl?enter=stcscsig-L

There’s no cost to join, and you can expect a very low volume of mail. Of course, the more
people join, the more traffic there’ll be, so please join. It’s a great way to make the SIG work for
you.

Two other mailing lists of interest to Science SIG members:

Copyediting-L: discussions of editing in all its various forms. To subscribe, send the message
“subscribe copyediting-L Your name” (with no quotes, and with your actual name instead of
“Your name”) to Listserv@listserv.indiana.edu

Techwr-L: discussions of the tools and travails of the technical writer. To subscribe, send the
message “subscribe techwr-L Your name” (with no quotes, and with your actual name instead
of “Your name”) to Lyris@lists.raycomm.com

the Exchange

Newsletter of the Scientific Communication SIG
Society for Technical Communication

901 North Stuart St., Suite 904

Arlington, Virginia

22203-1822 U.S.A.



